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Before You Start 

 

Purpose of this Document 

This document explains how to use the Amadeus Altéa Reservation Desktop 
Essential graphical user interface. 

Audience 

This document is intended for airline staff using Amadeus Altéa Reservation 
Desktop Essential. 

Latest Version of this Document 

For the latest version of this document, and other reference material: 

1. Connect to the Amadeus Airline Extranet: 

https://customers.amadeus.com/extranets/airline/index.jsp 

2. New users need to click on Register with Amadeus. 

3. When you are logged in, click on the Learning & Support link. 

4. If you have e-Support Centre access, click on the e-Support Centre link. 

If you don't have e-Support Centre access, or the link does not work, you 
need to register. To learn how to do this, click on the Registration Quick Card 
link. 

5. In the Amadeus e-Support Centre, browse or search in Reference Materials 
to find the document you need. 

Feedback on this Document 

Your feedback is very important, and will help us to improve this document. 

Please email us with your comments and suggestions: 

learning@amadeus.com 

What's New in this Document 
This is the first edition of this document.
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Chapter 1 

Getting Started 

What Is Amadeus Altéa Reservation Desktop 
Essential? 

Amadeus Altéa Reservation Desktop Essential is a flight reservation tool 
designed to fulfil the needs of airline agents. 

It provides a graphical user interface with the cryptic commands of the 
reservation system. 

It allows you to: 

• Search for available flights. 

• Search for fares and price flights. 

• Book flights. 

• Add service information to flight bookings. 

• Issue tickets. 

• Reissue and revalidate tickets. 

Signing In and Out of the System 

What Is a Sign? 
A sign is a combination of credentials to access the system. It is unique to an 
individual and provides a way to identify the actions taken. 

Depending on the attributes set by the Security Administrator, you may sign in 
using different types of credentials: 

• User Name and Password 

• Agent Sign, Office Id and Password 
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How to Sign In with a User Name 
1. In your internet browser, enter the URL provided to you by Amadeus. 

2. In the Sign-in panel, enter your user name and password. 

3. Your default office id is pre-selected automatically. 

For more information on office id, refer to What Is an Office Id? below. 

4. Check the Remember Me check box, if you want to keep your credentials for 
the next time you access the system. 

5. Click on Login. 

What Is an Office Id? 

An office id is a unique terminal code, that determines the access rights and 
security for all users of an office. 

The office id is structured as follows: 

NCE AF 0 100 

NCE Three-character IATA city or airport code. 

AF Two-character IATA corporate code for the airline, travel agency, hotel, car 
or other provider. 

0 Corporate qualifier code. 

100 Office code/type. 
 

How to Sign In with an Agent Sign 
1. In your internet browser, enter the URL provided to you by Amadeus. 

2. In the Sign-in panel, enter your agent sign. 

Note:  The agent sign includes four digits, two letters and a two-character 
duty code. For more information on duty codes, refer to What Are 
Duty Codes? on page 5. 

3. Enter your office id and password. 

For more information on office id, refer to What Is an Office Id? above. 

4. Check the Remember Me check box, if you want to keep your credentials for 
the next time you access the system. 

5. Click on Login. 
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What Are Duty Codes? 

A duty code restricts access to certain transactions. You can have multiple duty 
codes associated to your sign. 

Table: Duty Codes 

Duty Code Description 

AS Agent Sell (travel agents only) 

CE Customer Engineer 

GS General Sales Agent 

PD Pre/Post Departure Agent 

PR Programmer 

RC Space Control 

SU Supervisor 

TR TTY Reject Agent 
 

Note: Some duty codes may not be available in all markets. 

How to Sign In to Another Office 
You can sign in to an office other than your default one. 

1. In the User Name Sign-in panel, enter your user name and password. 

2. Uncheck the Sign In to Default Office check box. 

3. Check the Remember Me check box, if you want to keep your credentials for 
the next time you access the system. 

4. Click on Login. 

5. In the Select Office Id pop-up window, open the Office Id drop-down list. 

6. Select an office. 

7. Click on Login. 

How to Switch from an Office to Another 
When you are already signed in to one office, you can switch to another one 
without needing to sign out first. 

1. Click on the Office Id link at the top right-hand corner of the screen. 

2. In the Switch Office Context pop-up window, select the new office from the 
drop-down list. 

3. Click OK. 

How to Sign Out 
From the File drop-down menu select Logout or click on the Logout link. 
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What Happens After Prolonged Inactivity? 
After prolonged inactivity, you are automatically logged out for security reasons. 
This happens in two steps: 

• Lock session 

After a short period of inactivity, the current session is locked.  

To return to your session, enter your password in the window that is 
displayed. 

• Force logout 

After continued inactivity, a warning message is displayed that you will be 
logged out from the application in a certain number of minutes. 

If you enter your password within the specified time, you return to your 
session. If not, you are logged out from the application and any unsaved 
changes are lost. 

The time limits after which this happens are configurable and depend on your 
setup. 
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Overview: Navigation and Layout 

What Is the Home Page? 
The Home page provides access to the Amadeus central system as well as to the  
settings and tools. It is the area displayed when you start Amadeus Altéa 
Reservation Desktop Essential. 

You can go back and display the Home page at any time by clicking on the Home 
tab, in the task bar at the bottom of the screen. 

Here is an example Home page with an explanation of the different areas: 

 
 

 User ID and office ID of the user currently signed in. Click on the office ID link to 
sign in to a different office. 

 Logout link, allowing you to log out of the application. 

 Expanding sections providing access to the following functionalities: 
• Settings 
• Tools 

 Cryptic Window, providing access to the Amadeus central system. 

 Split Screen Icons, allowing you to divide the active session in up to 4 working 
areas. 

 Copy to Scratchpad link, allowing you to copy data to the Scratch Pad pop-up 
window. 

 Command History link, providing access to the Command History pop-up window. 

 Show Smart Flows link, allowing you to run the existing smart flows. 

 Task bar, allowing you to switch between Home page and other working sessions 
for the same office ID. Up to six tabs can be displayed. 
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Working in the Home Page 

How to Access the Cryptic Window 

1. In the Home page, expand the Tools section. 

2. Click on Cryptic Window. 

Example: Accessing the Cryptic Window 

 
 

How to Create Multiple Sessions 

From the task bar at the top of the screen, click on the Create New Session link. 
Alternatively, open the File drop-down menu and click on New Session. 

Note: You can open a maximum of 6 sessions. 

To switch sessions, click on the relevant Session tab, from the task bar at the 
bottom of the screen. Alternatively, use the commands Ctrl + Left or Right Arrow. 

How to Split the Screen 

From the Cryptic Window pane, click on the Split Screen icons to toggle on or off 

the working session's horizontal  and / or vertical  split. 

Note: You can split your session into a maximum of 4 working areas. 

Example: Working Session Split in Several Screens 

 



Chapter 1   Getting Started 

 

© 2013 Amadeus s.a.s. -  All Rights Reserved 9 
 

 

How to Re-Run Commands 

1. From the Cryptic Window pane, press Alt + Up Arrow to display the 
Command History pop-up window. 

2. Select the commands needed. 

3. Click on Execute. 

The commands are executed in the same order as displayed in the window. 

4. If you need to modify a command, select it, click on Paste in CW, modify the 
command directly in the Cryptic Window and Press Enter. 

5. Click on Clear History, to remove the commands on display. 

Working with the Session Information Window 

What Is the Session Information Window? 

The Session Information window is a pop-up that provides technical details about 
the session in use. 

You need to access this information if you are experiencing problems or need 
assistance from the help desk. 

How to Capture the Session Information Details 

1. Open the Tools drop-down menu at the top of the screen. 

2. Click on Session Information. 

3. From the Session Information pop-up window, use the left button of the 
mouse to select the technical details. 

4. From the internet browser bar at the top of the page, click on Edit to open the 
drop-down menu. 

5. Click on Copy. 

Note:  Alternatively to step 3 through to 5, click directly on Copy to Clipboard, if 
you are using Windows Internet Explorer as your browser.
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Chapter 2 

Managing Settings 

How to Change Your Password 
You can change your password at any time, not only when it expires: 

1. In the Home page, expand the Settings section. 

2. Click on Change Password. 

3. In the Change Password pop-up window, enter the current password, the 
new password and confirm the new password. 

4. Click on OK to save the new password. 

How to Change Your Email Address 
Your email address is needed when your password is reset, as an automatic mail 
will be sent to this address. 

Whenever your office email address changes, you should therefore update it 
immediately. 

1. In the Home page, expand the Settings section. 

2. Click on Change Email. 

3. In the Change Email pop-up window, enter your new email address, confirm 
it and enter your password to validate the change. 

4. Click on OK to save the new email address. 
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Customising the User Interface 
You can change the default look and preferences of the interface. 

How to Change the Colour Scheme 
1. In the Home page, expand the Settings section. 

2. Click on User Interface. 

3. In the User Interface pop-up window, click on the Color Scheme drop-down 
list. 

4. Select the preferred colour. 

5. Click on Apply to save the new scheme. 

How to Change the Font Size 
From the internet browser task bar, select Text Size from the View menu, or use 
the commands Ctrl + Plus key (+)  or Ctrl + Minus key (-). 

How to Change the Seat Map Display 
1. In the Home page, expand the Settings section. 

2. Click on User Preference. 

3. In the User Preference pop-up window, check or uncheck the Seat Map 
Graphical Display box to select whether the interface displays graphical or 
cryptic seat maps. 

4. Click on OK to save the new display preference. 

How to Change the Pricing Record Display 
1. In the Home page, expand the Settings section. 

2. Click on User Preference. 

3. In the User Preference pop-up window, check or uncheck the Pricing Record 
Graphical Display box to select whether the interface displays graphical or 
cryptic pricing records. 

Note: The pricing records impacted are Transitional Stored Tickets (TST) 
and Transitional Stored Miscellaneous Charges Orders (TSM). 

4. Click on OK to save the new display preference. 
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How to Change the Default Printer 
1. In the Home page, expand the Settings section. 

2. Click on Printers. 

3. In the Printer Settings pop-up window, click on the Set Printer drop-down list. 

4. Select the printer. 

5. Click on Set Default to save the new printer.
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Chapter 3 

Working with Smart Flows 

Getting Started with Smart Flows 

What Is Smart Flows? 
Smart Flows is a component that allows you to build and run pre-defined, 
customisable workflows. It helps you to complete recurrent tasks by using a set of 
smart flows triggered on request. 

You can create a personal smart flow (user level) or an office smart flow (office 
level). However, you must have administrator rights to create, share and edit an 
office smart flow. 

Once created, the status of a smart flow can be 'active' or 'not active', depending 
on whether or not you want it to be used. 

What Is the Smart Flow Editor? 
Smart Flow Editor is the tool used to create and manage smart flows. 

You access it by expanding the Tools section of the Home page and clicking on 
Smart Flow Manager. 

What Are the Smart Flow Modes in the Smart Flow Editor? 
The Smart Flow Editor allows you to build workflows through cryptic commands, 
or by using specific language. 

Command-Based Mode 

The command-based mode uses cryptic commands and allows you to add 
questions and variables to these commands. It is the default mode and the only 
one available for airline reservation agents. 

Advanced Language Mode 

Advanced mode allows you to create a smart flow using a specific language 
defined for smart flows. You must have administrator rights to use it. 
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When Can You Switch Between Modes? 
Note: You can only switch between modes if you have administrator rights. 

You can switch modes only when you create a new smart flow that has not been 
saved yet. 

When you reopen an existing smart flow, it opens in the mode that it was last 
saved and you cannot switch mode. 

How to Switch Between Modes? 

In the Smart Flow Editor pane, click on the Switch to Advanced Language Editor 
link. 

To go back to command mode, click on Undo Changes and Go Back to Smart 
Flow Editor. 

Note: You can only go back to command mode if you have not saved 
changes in the advanced mode. 

What Is the Smart Flow Language? 
The smart flow language is a logical syntax language. It is an alternative to the 
command mode.  

You can only use this language: 

• Through the advanced mode of the Smart Flow Editor. 

• If you have administrator rights. 

Reference: Smart Flow Language Syntax 

Statement Description Example 

ask Prompts you with a question. The question 
must be assigned to a variable. 
The string with the quotes between the 
words ask and assign to is the question 
that appears in the prompt when a smart 
flow is running. The string after assign to 
is the name of the variable in which the 
answer is stored. 

ask "What is your name?" 
assign to firstname 

send Send the cryptic entries. send "NM1SMITH/JOHN" 
send "NM1" + lastname + "/" 
+ firstname 
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Statement Description Example 

capture Capture part of the cryptic screen. The 
capture instruction is followed by three 
parameters: 
• Line: and a number to indicate which 

line of the screen the beginning of the 
string is captured. 

• Column: and a number to indicate 
which column of the screen the 
beginning of the string is captured. 

• Length: and a number to indicate the 
length of the string that is captured. 

The string after assign to is the name of 
the variable in which the captured string is 
stored. 

capture line:2, column:3, 
length:10 assign to lastname 

if, else Perform different actions depending on 
whether a condition evaluates to true or 
false.  
The if instruction is always followed by an 
expression that is between parentheses. 
The expression is a comparison between 
two terms that can be a variable or a 
constant. 
• The "==" operator verifies whether the 

two terms are equal. 
• The "!=" operator verifies whether the 

two terms are different. 
• The ">" operator verifies whether the 

first term is greater than the second 
term. 

• The "<" operator verifies whether the 
first term is less than the second term. 

• The ">=" operator verifies whether the 
first term is greater than or equal to the 
second term. 

• The "<=" operator verifies whether the 
first term is less than or equal to the 
second term. 

If the condition is true, the first block of 
instructions that is delimited by the braces 
is executed. 
If the condition is false, the second block of 
instructions that is delimited by the word 
else and braces is executed. 

ask "what is your 
destination?"  
assign to destination 
if (destination == "PAR") {  
send "rm ok"  
} else {  
send "rm no"  
} 
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Statement Description Example 

ask until This statement asks a list of questions until 
a particular answer is reached. 
The string with quotes between the words 
ask and until is the question that appears 
in the prompt when a smart flow is running.  
The string after the word until is the value 
of the answer that stops iterating another 
time over the block of instructions. 
The word when is followed by a value that 
defines the action. 

ask "Do you need to include 
visa information? 
1 : Yes - ESTA for the USA 
2 : Yes - other countries 
3 : No - continue" until "3" { 
when("1") { 
send "RIR for travel to the 
USA, an ESTA (online visa) 
is required 
} 
when("2") { 
send "RM no visa required" 
} 
} 

today The today variable is a global variable that 
is used to get the value of the date when 
executing a smart flow. The date is in the 
IATA format (DDMMM). 

send "rm visa information 
added on " + today 

choose Prompts you with a limited choice where 
only one choice is possible. 
The string within the quotes that follow the 
choose statement is the question that is 
asked when the smart flow is run. 
The when statements are the options that 
are provided for the question. The first 
when statement is the default.  
You can only choose one when statement 
by either selecting the radio button in the 
prompt or using the keyboard shortcuts 
from letters A to Z. 
When you make a choice, the content of 
the when statement is executed and the 
flow exits the choose block.  

choose "Do you want to" {  
when ("send pax remark") { 
send "rm 1" 
} 
when ("send comment") { 
send "rm 2" 
} 
} 

choose 
until 

Similar to the choose statement except the 
prompt continues to loop when the smart 
flow is run. 
The exit option is represented by the until 
statement. You can also exit by pressing 
the X key on the keyboard. 
When you make a choice, the content of 
the when statement is executed, after 
which the flow returns to the choose until 
loop unless you exit. 

choose "Do you want to" 
until "end" { 
when ("send pax remark") { 
send "rm pax" 
} 
when ("send comment") { 
send "rm comment" 
} 
} 

group The group instruction is used to group 
several questions in the smart flow prompt 
that are defined by the ask instruction. 
This allows you to include several 
questions in the same smart flow prompt 
rather than having separate prompts for 
each ask instruction. 
The group instruction can only contain an 
ask instruction; it cannot contain any other 
instructions. 

group { 
ask "Enter first name" 
assign to name 
ask "Enter last name" 
assign to lastname 
ask "Enter DOB" assign to 
dob 
} 
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Statement Description Example 

call The call instruction is used to call another 
smart flow from the running smart flow. 
The call instruction is followed by the name 
of the smart flow to call. 

ask "What is the passenger 
last name?" assign to 
lastname 
call "mySmartFlow" 
send "RM" + lastname 
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Creating Smart Flows 

How to Create a Smart Flow in Command-Based Mode 
1. In the Home page, expand the Tools section. 

2. Click on Smart Flow Manager. 

3. From the screen displaying the smart flows list, click on New. 

4. In the Smart Flow Editor pane enter a name, an optional description and the 
commands of your new smart flow. 

For help on how to write commands for smart flows, move the mouse over 
the How to Write Smart Flows link. 

5. Click on Save. 

Note: When you save a smart flow, the editor stamps it with the date and 
time of the latest update. 

Example: Command Based Smart Flow 
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Using Questions in Smart Flows 

What Is the Purpose of Creating Questions? 

Creating questions facilitates the use of smart flows. You define the relevant 
questions for a set of commands. The questions are then displayed as a prompt 
when the smart flow starts to run. 

Answering the questions triggers entering and processing the related commands 
in the Cryptic Window. 

How to Create a Question in Command-Based Mode 

1. Create or open a smart flow in command-based mode. 

See How to Create a Smart Flow in Command-Based Mode on page 20 or 
How to Open a Smart Flow on page 25. 

2. With the mouse cursor, select the part of the command for which you want to 
create the question. 

3. Click on Create New Question. 

4. Enter a label for the question in the Label field. 

5. Enter the question to be displayed in the prompt in the Question field. 

6. Click on Save. 

Note:  A blue rectangle shows the sections of a command that are 
associated to a question. The rectangle becomes orange when the 
question is selected for editing. 
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Example: Smart Flow With Questions 

 
 

How to Edit a Question 

1. Open the smart flow in command-based mode. 

See How to Open a Smart Flow on page 25. 

2. Click on the section of the command relating to the question. 

3. Edit the question as required. 

4. Click on Save. 

Note:  Changes made to a question are saved automatically even if you do 
not click on Save. Therefore, if you edit a question and then start 
editing another, the changes to the first question are saved 
automatically. 

How to Delete a Question 

1. Open the smart flow in command-based mode.  

See How to Open a Smart Flow on page 25. 

2. In the Smart Flow Editor pane, click on the label inside the coloured 
rectangle. 

3. Place the mouse cursor at the beginning of the label and, at the same time, 
left-click and press the Delete key. 

4. Click on Save. 
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How to Create a Smart Flow Using the Command History 
1. In the Cryptic Window, display the commands entered previously. 

See How to Re-Run Commands on page 9. 

2. In the Command History pop-up window, select the commands you want to 
use in the smart flow. 

3. If you want to edit the commands before copying, click on the Switch to 
Advanced Mode link and update as required. 

4. Click on Create Smart Flow. 

The application automatically switches to the Smart Flow Editor and pastes 
the selected commands in a new smart flow. The commands can either be 
edited, saved or have questions added to them. 
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How to Create a Smart Flow in Advanced Language Mode 
Note: You must have administrator rights to create a smart flow in advanced 

language mode. 

1. In the Home page, expand the Tools section. 

2. Click on Smart Flow Manager. 

3. From the screen displaying the smart flows list, click on New. 

4. Click on the Switch to Advanced Language Editor link. 

5. Enter a name, an optional description and the content of your new smart flow. 

For more information on Advanced Language syntax, refer to Reference: 
Smart Flow Language Syntax on page 16. 

6. Click on Save. 

Note: If you save changes in advanced mode, you cannot go back to 
command mode. 

Example: Advanced Language Smart Flow 
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How to Create a New Smart Flow from an Existing One 
Note:  You must have administrator rights to create a new office smart flow 

from an existing office smart flow. 

1. In the Home page, expand the Tools section. 

2. Click on Smart Flow Manager. 

3. From the screen displaying the smart flows list, select the smart flow that you 
want to copy. 

4. Click on Copy to New. 

The new smart flow opens in the same mode as the original (command or 
advanced mode). The name field contains the string "Copy of <name of the 
selected smart flow>" and all other fields are pre-completed with data from 
the existing smart flow. 

Managing Your Smart Flows 

How to Open a Smart Flow 
1. In the Home page, expand the Tools section. 

2. Click on Smart Flow Manager. 

3. From the screen displaying the smart flows list, select the smart flow that you 
want to open. 

4. Click on Open. 

Alternatively, double-click on the smart flow. 

How to Edit a Smart Flow 
Note:  You must have administrator rights to edit an office smart flow. 

1. In the Home page, expand the Tools section. 

2. Click on Smart Flow Manager. 

3. From the screen displaying the smart flows list, select the smart flow that you 
want to edit. 

4. Open the smart flow. 

Note: A smart flow is opened in the mode that it was last saved, either 
command-based mode or advanced language mode. 

5. Update the fields as required. 

6. Click on Save. 
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How to Activate a Smart Flow 
Note:  You must have administrator rights to activate an office smart flow. 

1. In the Home page, expand the Tools section. 

2. Click on Smart Flow Manager. 

3. From the screen displaying the smart flows list, select the smart flow that you 
want to activate. 

4. Click on Activate. 

Alternatively, select the Activate Smart Flow check box in the Smart Flow 
Editor and click on Save. 

How to Deactivate a Smart Flow 
Note:  You must have administrator rights to deactivate an office smart flow. 

1. In the Home page, expand the Tools section. 

2. Click on Smart Flow Manager. 

3. From the screen displaying the smart flows list, select the smart flow that you 
want to deactivate. 

4. Click on Deactivate. 

The deactivated smart flow is no longer available in the Show Smart Flows 
section of the Cryptic Window and cannot be run. 

How to Delete a Smart Flow 
Note:  You must have administrator rights to delete a shared or office smart 

flow. If you delete a shared smart flow, it is deleted from all offices that it 
was shared with. 

1. In the Home page, expand the Tools section. 

2. Click on Smart Flow Manager. 

3. From the screen displaying the smart flows list, select the smart flow that you 
want to delete. 

4. Click on Delete and confirm. 

Running and Stopping Smart Flows 

What Happens When You Run a Smart Flow? 
When you run a smart flow, the commands that it contains are entered in the 
Cryptic Window. 

If the smart flow contains questions or instructions, it triggers a prompt that allows 
you to answer using free text or choose from a list of options. 
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How to Run a Smart Flow 
1. In the Home page, expand the Tools section. 

2. Click on Cryptic Window. 

3. In the Cryptic Window pane, expand the Show Smart Flows link. 

Note: If you have personal and office smart flows, they are displayed in 
separate folders. 

4. Click on the smart flow you want to run. 

Note: You may be asked to fill in a prompt, if the smart flow includes 
questions. 

5. To stop running the smart flow, click on Stop, from the Smart Flow prompt. 

Note:  You can only stop a smart flow when it triggers a prompt.
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Chapter 4 

Using the Scratch Pad 

What Is the Scratch Pad? 
The Scratch Pad is a pop-up window that allows you to copy and paste text 
between areas. 

It displays on top of the current screen and on top of any other pop-up windows 
present. It can be opened and closed at any time. 

The data pasted is kept until you click on Clear, logout or your session is timed 
out. 

Working with the Scratch Pad 

How to Access the Scratch Pad 
1. In the Home page, expand the Tools section. 

Alternatively, open the Tools drop-down menu. 

2. Click on Scratch Pad. 

How to Enter Information in the Scratch Pad 
1. In the Home page, expand the Tools section. 

Alternatively, open the Tools drop-down menu. 

2. Click on Scratch Pad. 

3. Type or paste copied data into the text area. 

Note: If you want to copy data from the Cryptic Window, click on the Copy 
to Scratchpad link. 

How to Clear the Scratch Pad 
From the Scratch Pad pop-up window, click on Clear. 

Alternatively, log out of the system. 

Note: The scratch pad clears automatically after a session timeout.
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Appendix A 

Keyboard Shortcuts 

The following table describes the keyboard shortcuts available. 

Table: Keyboard Shortcuts 

Action Shortcut 

Display Session Information Alt + F1 

Display the Scratch Pad Alt + F2 

Display the Command History Alt + Right Arrow  

Recall previous or next entry from the Command History Alt + Up Arrow 
Alt + Down Arrow 

Clear the Cryptic Window Pause 

Clear the session history Shift + Pause 

Enter Move up (MU) command in the Cryptic Window F7 

Enter Move down (MD) command in the Cryptic Window F8 

Switch to the next or previous session Ctrl + Left Arrow 
Ctrl + Right Arrow 
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